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INTRODUCTION

Who’s This Book For?

This book is for anyone who likes to shoot landscape and outdoor photos and
wants to learn some of my proven ways to get the most out of them in Lightroom
and Photoshop. While the book isn’t advanced, it's also not a beginner’s book. I'm
assuming you know how to use Lightroom and Photoshop already, so | won't be
explaining what each slider does or the theory behind every setting, etc. | just
show you, quick and easy, each step in my landscape photography workflow.

What Will You Learn in This Book?

First, I've included some things that you'll want to know upfront. Then, | go over
each of the things that | personally do to just about every landscape photo | shoot.
That way, | don’t have to write it over and over again in each photo example.
Finally, we’ll look at five of the most common types of landscape shots, and | show
you my exact workflow for each one. (Note: I've made these images available for
you to download, so you can follow along. You can find them at
http:/Ikelbytraining.com/books/landscapel.) While there are, of course, a ton
of different ways to post-process your landscape photos, here | show you how |
do it. So, if you're thinking to yourself that there may be another way to sharpen
your photos that you read in another book or saw in a YouTube video, you're right,
there probably is. And, once you get your workflow down, feel free to try out any
other ways you're familiar with to see what works best for you.

| hope you enjoy taking a look at my landscape photography workflow.


http://kelbytraining.com/books/landscape1
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CHAPTER 1

THE LIGHTROOM
AND PHOTOSHOP
CONNECTION

First up, | just wanted to go over a few things about using Lightroom and
Photoshop and what | use in my own personal workflow.




CHAPTER 1: THE LIGHTROOM AND PHOTOSHOP CONNECTION



WHAT IF | DON'T USE LIGHTROOM?

Throughout this book, | start out in Lightroom with all of the examples, but then we
jump over to Photoshop for any cloning, healing, touchups, and finishing moves.
Now, what if you don’t use Lightroom? No sweat. Adobe Camera Raw (which
comes free with Photoshop CC, CS6, CS5, etc.) is the exact same thing. Every
panel in Lightroom has a corresponding panel in Camera Raw. There is one key
difference, though: Lightroom has a dark interface and Camera Raw has a light
interface. Seriously! When it comes to developing and editing your photos, that’s
the only real difference. They're the same thing. So if you see me adjusting a
setting in Lightroom, just know you can do the exact same thing in Camera Raw
(if you don’t use Lightroom).
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| DON'T SHOOT RAW. WHAT ABOUT
JPEGS?

Again, no sweat. If you're using Lightroom, it'll treat JPEGs almost exactly the
same as RAW files. The only difference is that you don't get all of the white
balance presets in the Basic panel (as seen here), or all of the Profile presets in
the Camera Calibration panel (also seen here). However, | don't use either of
those presets much in this book, so whether you shoot RAW or JPEG doesn't
really matter here.
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HOW DO | OPEN A JPEG IN CAMERA
RAW?

Now, there is one tiny gotcha: If you're going to use Camera Raw instead of
Lightroom, there’s a little trick to opening a JPEG. You see, RAW files open
automatically in Camera Raw when you open them in Photoshop, but JPEGs
don’t (I know it sounds weird, but even though it's called Camera Raw, it's meant
for editing JPEGS, too). To open a JPEG image in Camera Raw, first open it in
Photoshop, then go to the Filter menu, and choose Camera Raw Filter. (Note:
This option is only available in Photoshop CC. If you have an older version of
Photoshop, you'll need to choose Open [PC: Open As] from Photoshop’s File
menu, then click on your JPEG in the Open dialog, and choose Camera Raw
from the Format [PC: Open As] pop-up menu.)
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BUT CAN'T | ALSO DO IT THIS WAY?

One last thing: If you're reading through a technique and think to yourself “But,
can't | also do it some other way?” the answer is absolutely “Yes.” As you
probably know by this point, there are 10 different ways to do everything in
Lightroom and Photoshop. All | can show you is the way | do it. | don’'t want to
take up your time showing you seven ways to sharpen a photo. I'd rather just
show you the way | do it. If you're advanced enough to know the other ways, then
feel free to give them a try. Perhaps they work better for you, but for me the best
ways I've found to do things are written right here. Also, you're going to see me
using my secret weapon from time to time—Perfect Effects, found within a plug-in
from onOne Software called Perfect Photo Suite 8. | use it on just about every
photo | process. Now, | could leave this out of the book and never show it to you
for fear that someone might complain that I'm using an “extra” piece of software
that maybe you don’t have. But, then | wouldn’t be showing you my workflow. So,
I’'m including it, because it's the way | sharpen and add detail to my photos. Now,
just in case you don’t have the plug-in and don’'t want to buy it, | will show you
how to sharpen your photos without it. Sound good? Cool! Let's go ahead and get
started :-)









CHAPTER 2

gl S TURNE
| DO OVER AND
OVER AGAIN

In this chapter, we'll take a quick look at all the things in my workflow
that | usually do to all my landscape photos.




CHAPTER 2: THE STUFF I DO OVER AND OVER AGAIN



WHITE
BALANCE

For landscapes, | almost always prefer a warmer photo. So, the white balance
sliders are usually where | start. For most sunrise and sunset photos, I'll usually
shoot in my camera’s Cloudy white balance mode. But when | process the photo,
I'll typically make it even warmer by moving the Temp slider to the right a little.

The only time | really look for a different feel and color from my photos is for
photos taken during twilight. Those typically have a cooler feel and even have
some reds or magentas that stand out. In that case, I'll adjust the Temp slider
toward the left a little and the Tint slider to the right to really bring out those colors.






EXPOSURE

Think of the Exposure slider as the sledgehammer of the adjustments. It's a broad
adjustment that’s going to pretty much make the entire photo brighter or darker.
When it comes to my landscape photos, | usually go to Shadows and Highlights
first (covered next) and adjust them. After that, | look at the overall feel of the
photo and decide if it needs to be brighter or darker, and then adjust the Exposure
slider accordingly. But, just so you know, you have a ton of control with this slider.
| often photograph beaches and waterfalls and, rather than constantly putting a
neutral density (ND) filter on and off my lens, | shoot in aperture priority mode and
over- or underexpose the photo to change the shutter speed. Here’s an example
of an overexposed photo at a beach. | love the pattern of the water that the longer
shutter speed gives, but you'd normally think it was way too bright.

But, by just adjusting the Exposure slider (along with the Whites slider, here), I'm
able to regain all of the details in the photo. This gives me the best of both worlds.
I’m able to shoot longer shutter speeds without worrying about putting an ND filter
on and off, and I'm still able to capture the details and patterns in the water that
you get from those longer shutter speeds.






HIGHLIGHTS AND SHADOWS

These are two of the star performers when it comes to editing landscape photos.
If you think about it, when you're outside, you have very little control over the
conditions. The sun can be so bright, and dark shadow areas can be so dark, that
it's nearly impossible for a camera to actually capture what we see. That's where
the Highlights and Shadows sliders come in.

Here’'s a great example: When the sun is coming up, the sky gets really bright,
but the ground remains dark. So, you'’re faced with a choice because your camera
can’t capture both and expose them properly. Do you expose for the sky or for the
foreground? Me, | just let the camera determine the exposure and make sure I'm
not totally blowing out the highlights and bright areas in the sky, and then | use the
Highlights slider to bring back some of that detail (you'd be amazed at how much
Is lurking in there ready to be revealed).

Before

Highlights

The same goes for the shadowy or darker areas. Just drag the Shadows slider
to the right and you'll see those darker areas open up with detail, while the rest of
the photo remains untouched.



Shadows



WHITES AND BLACKS

Setting the whites and blacks gives you a good overall base for your photo, so
that your tones cover the entire range from highlights to shadows. For most
landscape and outdoor photos, you'll see that we can use a formula to help out.
First, press-and-hold the Option (PC: Alt) key and then click on the Whites slider.
Everything usually turns black, unless you have a blown out or overexposed area
in the photo already. Once you see the black screen, drag the slider to the right.
When you start to see little specks appear, that means Lightroom is showing you
a white point. Don’t worry if they’re different colors; just keep dragging until you
see some specks of any color. Once you do, release the Option key and take a
look. Those little specks are usually something that was really bright in the photo,
like bright clouds, highlights on water, snow, or anything else that was close to
white.

Before

Blacks

Now do the same thing for the blacks. Just Option-click on the Blacks slider and
everything turns white. Drag it to the left, and you’ll see some specks again,
meaning that you now have a black point. Keep in mind that sometimes you need
to step in and decide how far you really should go. What | just showed you is a
good guide, but if you're photographing some water and a sky at sunset, you may
not have a white or a black point because nothing in the photo is pure white or
pure black. But, it is a good formula to try out, and | think you’ll see it works great
on most photos.



Whites



CROPPING AND STRAIGHTENING

There’s nothing too earth shattering here when it comes to cropping. If the photo
needs to be cropped to a specific ratio, I'll usually try to do that early on so | can
get rid of any unnecessary details. When it comes to landscapes though, the
Straighten tool can be a lifesaver. Just click on it (it can be found within the Crop
Overlay tool’s options; it's icon is the little level), and then drag it across whatever
should be straight in your photo. If you have an obvious horizon line, like when
you're shooting at the beach, then it's simple—just drag it along the horizon to
straighten the photo. But, when you don’t have an obvious horizon, it's not always
that simple. For example, when shooting lakes and mountains, you may not have
a horizon to base your straightening off of. In that case, | usually just drag the
Straighten tool along the shoreline of a lake and that usually does the trick. And, if
you're really stuck, remember that trees (usually) stand straight up, so you can
always try dragging the Straighten tool vertically along a tree to see if that helps.



Before




ENHANCING THE SKY

Much of what we do in landscape photography involves the sky, so it's a really
important area to work on. One of the most common issues we have is when the
sky is too bright. Sure, you can try to use the Exposure and Highlights sliders to
darken it, but those are global changes that’ll affect your whole photo. So, instead,
you'll want to get cozy with the Graduated Filter (M; it's the third icon from the right
in the toolbox above the Basic panel). It works a lot like a graduated neutral
density filter works in the field. The filter goes from dark to clear, and you hold it in
front of your lens to darken the sky, but leave the foreground alone. It's the same
thing here. First, reduce the Exposure setting in the Graduated Filter’s options. |
always start around —2.00 (but you can change this later). Then, drag downward
over the sky toward the horizon line. The more you drag, the more you spread out
and smooth the effect of the filter, so you don’t see a harsh line across your sky.
Then, when you're done, you can go back and adjust the Exposure to make the
sky darker or brighter.

Before Darker

What's really nice about the Graduated Filter is that you don’t have to adjust just
the Exposure—there are a bunch of other settings in its options, like Saturation,
Clarity, Highlights, and Shadows. Also, my personal favorite is the Temp setting at
the top. We often want our landscape photos to have a warm feeling to them. As a
result, your skies will tend to look muddy. By moving the Temp slider to the right,
you can add some blue to just the sky, so everything else in the foreground stays
nice and warm.



More Blue



DRAWING

ATTENTION

TO AN AREA/ADDING A
VIGNETTE

Just about every outdoor photo can benefit from a finishing effect: a vignette.
Think of it as a tool to help draw the viewer into the photo and really help them
avoid the distractions we usually see along some of the edges of an image. There
are two ways | do this: using the Post-Crop Vignetting settings in the Effects panel
or with the Radial Filter that was introduced in Lightroom 5. Let's look at the
vignette settings first.

Vignette Method 1:

| usually use the Effects panel to add a vignette. For me, it simply darkens the
edges and really helps draw the viewer into the photo. Luckily, it's really simple to
use. Just drag the Amount slider to the left and you’ll see the edges get darker.
Usually somewhere between —20 and —40 works, so don’t get carried away here.
I'll usually drag the Midpoint slider to the left to bring the effect in toward the
center a bit, too. Finally, I'll drag the Feather slider to the right to soften the
transition between the dark edges and the rest of the photo.

Before

Effects panel



LET'S GET STARTED!

Vignette Method 2:

The only time | resort to this method is if | have a strong focal point in the photo
that's not in the center, and | want to make it stand out. Take the small white
house in this photo as an example—it's off to the side. The vignette settings we
used in the previous method would darken the edges and make the house darker.
So, instead, I'll use the Radial Filter (Shift-M). Just click on its icon in the toolbox
(it's the second icon from the right), then double-click on the word “Effect” to reset
all of the sliders to zero. Now, just drag the Exposure slider to the left to around —
2.00. Position your cursor over whatever it is you want to draw attention to in the
photo, and then click-and-drag a circle (or oval if it works better) outward. The
further out you drag it, the softer the transition will be—it’'s kind of like putting a
little spotlight on parts of your photo. And, if the effect is too dark (or not dark
enough), go to the Exposure slider and adjust it live on the image to get it just
right.

Before

Radial Filter

Well, that's the list of all of the usual stuff | do to my landscape photos. For the
rest of the book, we’ll walk through editing some photos from start to finish, and
you'll see how they all come together, as well as learn a few new tricks.






CHAPTER 3
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THE SUNRISE/
SUNSET PHOTO

Sunsets and sunrises are probgbly some of the most popu|ar fypes of
landscape photos. But, sunsets definitely win out because everyone is
awake when it happens. Me, personally? Even though I'm sooco not
an early riser, | do like photographing sunrises. There's just something
about caiching the first light of the day.




CHAPTER 3: THE SUNRISE/SUNSET PHOTO

This photo was taken at the Dallas Divide, which is a high mountain pass just
outside of the town of Ridgway, Colorado.

First we’ll crop and straighten the photo. This is a tough one to straighten
though, because there’s no horizon line to base your adjustment on. When this
happens, we can actually use a vertical surface instead. In Lightroom, | chose the
Crop Overlay tool (R). Then, | selected the Straighten tool and simply clicked-and-
dragged vertically along one of the trees. It's not a perfect science because who’s
to say exactly which tree is standing perfectly upright, but you can get pretty close
this way.



Next, | adjusted the white balance Temp slider, moving it toward the right to
take advantage of the warm tones and make them a little warmer. After that, |
reduced the Exposure setting because the photo looked a little too bright overall.
Once the overall exposure looked good, | dragged the Highlights slider to the left
to tone down only the sky a bit (don’t worry, we’'ll make it even darker later).
There’s really nothing lost in the shadows in this photo, so | left that slider alone.




Whites and Blacks come next. Here, | used the trick | talked about in the
Chapter 2: Simply press-and-hold the Option (PC: Alt) key and click-and-drag the
Whites slider toward the right until you see some specks of color start to appear
(as shown here), meaning you have a good white point. Then, | did the same
thing with the Blacks slider, so we have good white and black points in the photo.
Finally, | finished things up with a Clarity adjustment to add some more detail and
contrast to the photo.




Another adjustment | make to photos with lots of color is in the HSL panel.
By looking at the photo, you can see what some of the key colors are. Here, |
think they’re the oranges, yellows, and greens. By going under the Luminance
section of the HSL panel, you can move those sliders to the right and make those
colors appear brighter, which | think works out great in this example (especially
with those bright yellow aspens).

Sharpening is an important part of landscapes. In the Detail panel, you can
adjust the Sharpening Amount. For landscapes with a lot of detail, I'll usually
crank it up in the 80-100 range. | set the Radius at around 1.0-1.4 for just about
every photo, and then increase the Detail slider to around 30-40. (Note: If you've
got onOne Software’s Perfect Effects in Photo Suite 8, I'm going to show you a
great finishing technique that adds detail and sharpens at the same time. So, if
you have it, you can skip this step and sharpen later.)



At this point, | think the sky is still too bright. The Graduated Filter (M) will
work perfectly here. Just click on it in the toolbox, reduce the Exposure setting,
and then click-and-drag from the top of the photo down. Since we warmed the
photo earlier, | always move the Temp slider to the left (toward the blue side) to
bring some blue back into the sky while darkening it at the same time.

While we’re working with tools, now would be a good time to check for any



spots in the sky. The Spot Removal tool (Q) can not only fix the spots, but help
you find them, too. Once you select the tool from the toolbox, turn on the Visualize
Spots checkbox under the preview window. You'll see a really weird looking black-
and-white version of the photo. But, more importantly, any spots in the sky should
stick out and you can just click with the Spot Removal tool to get rid of ‘em. It's a
good idea to memorize the keyboard shortcut for turning the Visualize Spots
option on and off: it's the A key. Also, it's not a bad idea to zoom in when you do
this to get a really good look at the sky.

Finally, just about every photo | edit gets a vignette. For this photo, the Post-
Crop Vignetting options in the Effects panel work just fine. Decrease the Amount
setting to darken the edges (as shown here), then adjust the Midpoint setting to
help hide the edges and soften the transition from the dark part of the vignette to
the unaffected areas.

Well, that's pretty much it for this photo. But, next, I'm going to show you one of
my secret weapons for landscape photos. Just be aware that it's a third-party
plug-in, so it doesn’t automatically come with Lightroom. But, if you want to see
how | really finish my photos, then this is it.



The plug-in | use is called Perfect Effects and it's included in onOne Software’s
Perfect Photo Suite 8 (even though earlier versions of the suite have Perfect
Effects, the specific effect I'm using here isn’t included in them).

If you have the Lightroom version of the plug-in installed, just go under the File
menu, under Plug-In Extras, and choose Perfect Effects 8. (Note: You'll want to
choose it through the File menu, rather than from the Edit In menu, under the
Photo menu, because you get some better options this way.) Now, once your
image is open in Perfect Effects, the specific effect | was talking about earlier is
called Dynamic Contrast—it adds detail, clarity, and contrast to your photo all at
once. The best part about it is that it lets you apply it to parts of your photo that
need it and keeps the parts that don’t from getting that ultra-grungy, fakey look.
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Once the Dynamic Contrast filter is selected on the left, | always choose the
Natural setting. Then, on the right side of the window, you’'ll see all of the sliders
that can adjust the effect in more detail. The main ones | use are in the Detalil
section (Small, Medium, Large) of the Filter Options panel. You basically adjust
the slider that most fits the details you want to add contrast to. For example, |
think the trees here would fall into the small and medium categories. The
mountain range in back is probably more on the medium side. If you had puffy
clouds in the sky, they’'d be larger details, and you could really add some contrast
to them (even though we don’t have them here). When you're done, click Apply
and you’ll be taken back to Lightroom with a new copy of your photo, right beside
the original, with the Dynamic Contrast effect applied.









CHAPTER 4

SHOOTING INTO
THE SUN

Shooting directly at the sun is one of my favorite things to do in
lcmdscqpe pholography. You see, |qnd5cupe$ can be very static, but
when you include the sun just as it goes below (or comes up cbove) the
horizon, mountain peak, or tree, | feel like it captures a very speﬂi_ﬁc
moment in time, rather than just a static scene where the viewer doesn’t
have that connection. So, | often set my aperture to /16 (the small
aperture seffing is what helps give you that sunburst star effect) and wait
for that Ic'ey moment. '




CHAPTER 4: SHOOTING INTO THE SUN

The game plan for this image is to brighten it quite a bit. Here, | captured the
setting sun just before it went behind the hills in Death Valley’s popular Racetrack
Playa. Whenever you shoot into the sun, your camera’s meter is most likely going
to capture a darker photo, so that it doesn’t totally blow out the sky and make it all
white. As a result, you'll need to brighten things up a bit, while still keeping the sky
under control. Also, in this image, there are a bunch of little rocks in the
background that would just look like sensor dust spots if we left them, so we’'ll
need to clone those out. Lastly, that rock in the foreground is one of the main parts
of the photo, but it's really dark, so we’ll have to brighten it up more than the rest
of the foreground area so it stands out.

Start off by increasing the Exposure and Shadows to brighten up the entire
photo and bring out the dark areas. Then, pull back on the Highlights slider, so
that we bring back some detail in the sky. Follow that up by adjusting the Blacks
and Whites sliders (you can use the Option-click [PC:Alt-click] trick that we’'ve
used before to find the black and white points). | also adjusted the overall white
balance to make the photo warmer and even added a little red to it by moving the
Tint slider to the right a little.



The Graduated Filter comes in really handy on the sky, once again. Select it
from the toolbox, then reduce the Exposure setting to darken the sky, reduce the
Temp setting to add some blue, and then drag the filter downward, so it just
affects the sky area.

The photo looks a little distorted (curved) along the base of the mountains.
You can almost see a curvature, which happens a lot with the wide-angle lenses



that we typically use for landscapes. If you notice this, just go to the Lens
Corrections panel and, in the Basic section, turn on the Enable Profile Corrections
checkbox (as shown here), and you'll see Lightroom automatically makes some
adjustments by looking at the camera and lens that you captured this image with.

Overall the photo needs some more contrast and maybe even a color boost.
One of the settings | always like to try is in the Camera Calibration panel. If you
shoot in RAW (it doesn’t work with JPEGS), you can adjust the Profile setting to
enhance your photo. The settings are camera-specific, so they may be called
something different for the photo you're looking at, but for my Nikon D800, the
Camera Landscape setting works really well here.



Now, one thing that’s bothering me is the rock in the foreground. It's really
one of the focal points in the photo, but it's so dark. Heck, those rocks are why
you go to photograph the Racetrack Playa in the first place. So, it'll need to get
brightened, and one of the best tools that can do that is the Adjustment Brush. It
works a lot like the Graduated Filter, but it uses a brush rather than a gradient line.
Zoom in on that rock, then select the Adjustment Brush (K) from the toolbox, and
increase the Exposure and Shadows settings. Now, just paint over the rock to
make it brighter (as shown here). If your brush is too big, and you paint on the
outside of the rock, just press-and-hold the Option (PC: Alt) key to switch the
brush to Erase mode and paint to remove any of the spillover areas.



Now it’s time for some retouching. Those smaller rocks in the back will end up
looking like sensor dust spots or just spots on the photo if we were to print this
image. They’re just not big enough to show up and people that have never been
to the Racetrack Playa would never know what they were. So, let’s get rid of ‘em.

Your first thought may be to use Lightroom’s Spot Removal tool for the Clone
and Heal features it has. It's mine too, so let’'s give it a try: Select the Spot
Removal tool (Q) from the toolbox and brush over one of the rocks. Whether you
have the tool set to Clone or Heal doesn’t really matter here because the result is
the same. The tool, though, is so haphazard in the area it chooses to fix from—
look how far away it chose a source area (the top selection) to use to remove this
rock.



Well, you've got two options: you could always click on the sample area and move
it closer to the rock to “help” it along, or you could use Photoshop since it has
superior cloning and healing. Since Photoshop will be a lot faster (and we haven’t
jumped over there yet in this book), we’ll go with that route. So, go under the




Photo menu, under Edit In, and choose Edit in Photoshop CC (or CS6, CS5, or
whatever version you're using). This opens a copy of your photo in Photoshop,
where you can now use all of its retouching tools to help get rid of any
distractions. Get the Clone Stamp tool (S) from the Toolbox, then, press-and-hold
the Option (PC: Alt) key and click to sample an area right next to a rock. Then,
just paint over the rocks to remove them.

When you're done, go under the File menu and choose Save to save your
image, and then close it. Don’t change the name or location or do Save As. Just
save and close it, and Photoshop and Lightroom take care of getting a copy of the
image back into Lightroom right next to the original.
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Now that we’re back in Lightroom, it’'s time for some finishing touches. You
could use the Detail panel to sharpen the photo and you'd be done. But, this is
another one of those photos that would benefit from Perfect Effects, which we
used in the previous chapter. If you have it, go under the File menu, under Plug-In
Extras, and choose Perfect Effects 8. Again, I'm going to add the Dynamic
Contrast filter like we did before. But, this time, I'm also going to add a new layer
in Perfect Effects’ Filter Stack panel, add the Sunshine filter, and use the Glow
preset (as seen here). It's a nice effect for sunrise and sunset photos to add just a
little bit of extra warmth to the image. When you're done, hit the Apply button to
return to Lightroom.



The last thing that the photo needs is a vignette. For this photo, once again,
the Post-Crop Vignetting settings in the Effects panel work just fine. Decrease the
Amount setting to darken the edges, then adjust the Midpoint setting to help hide
the edges and soften the transition from the dark part of the vignette to the
unaffected areas.







CHAPTER B

THE TWILIGHT
LANDSCAPE

Twilight is one of my favorite times to shoot. We often have it drilled into
our minds that the only time to shoot is when the sun is coming up or
right when it's going down—basically, a key few minutes ecich day. But,
you can capture some beautiful photos during twilight, too. The land-
scape around you won't be totally dark, since the recently set sun sill
reflects off the atmosphere, and it won't be totally light—it's somewhere
in between.




CHAPTER 5: THE TWILIGHT LANDSCAPE

Here's a photo of Bonsai Rock at Lake Tahoe, which is near Sand Harbor. |
actually photographed this when the sun was still up and kept shooting right as it
was going down. But, to me, | really like the twilight version better. It just has a
certain mood to it that the sunlit photo doesn't.

| think part of shooting landscapes is also knowing (and taking advantage of) the
things that you can do in Lightroom and Photoshop. This photo is a great
example. The light was literally changing by the minute. In the clouds, on the
rocks, the sky...you name it. | wanted a longer exposure/shutter speed because it
helps to smooth the water out, so it doesn’t have so many ripples in it. But, since it
was getting dark and the light was changing so fast, | opted not to put my neutral
density filter on to slow the shutter speed. Instead, | just overexposed the photo a
bit. The result: smooth water and a slightly bright sky. But, | think this is a great
example because it shows how much flexibility we have in Lightroom with
exposure and toning adjustments.



Let’s start with Highlights and Shadows. We want to darken the sky, so
reducing the Highlights will help. Then, adjust the Shadows slider to open up
those darker areas up front on the rocks. From there, adjust the Whites and
Blacks sliders and remember that there probably isn’t a pure white point in this
photo, so there’s no need to push the Whites slider until you see one. Now,
overall, if you feel you need to make the whole photo brighter or darker, then
adjust the Exposure. In this photo, | thought it was good as is, so I'm leaving it at
0.

White balance is a really important part of twilight photos. Remember,
twilight is all about color. It's color that you can’t get any other time of the day, so
we want to take advantage of it. Now, white balance is a very creative adjustment
for landscape photographers—it really depends on how you view the scene and
how the landscape “feels” like it should look. For me, | tend to keep my sunset
and sunrise photos very warm. If the sun is there, then it should have a warm
feeling. But, the colors change during twilight. | tend to drag the Temp slider
toward the cooler/blue side and the Tint toward the right to a more magenta color.
It really helps with those subtle blue and pink/red colors we see in the sky.



Next, | usually add some clarity, and even a little saturation if the photo
needs it. | know the Saturation slider usually gets a bad reputation, but if you use
it sparingly it's not bad at all—especially for landscapes. While the Vibrance slider
works great on portraits, Saturation boosts the colors in everything, which | think
Is exactly what we want in a landscape photo. There’s also some dark vignetting
along the edges of this photo, so go to the Lens Corrections panel and turn on the
Enable Profile Corrections checkbox and Lightroom will automatically fix it. It's
usually a good idea to turn on Remove Chromatic Aberration, too, as it will
remove any of those color fringes we see when we shoot with wide-angle lenses.



Whenever you have a photo with a strong subject or focal point that’s not in
the center, it’'s a good time to use the Radial Filter. It's basically another way of
adding a vignette. Because vignettes make the edges darker and leave the middle
alone, this is another way to make something (not in the center of the image)
stand out—it's almost like putting a spotlight on something. Just get the Radial
Filter (Shift-M) from the toolbox, then reduce the Exposure setting, place your
cursor over whatever it is you want to draw attention to (Bonsai Rock in the top
left here), and then click-and-drag outward. The larger you make the circle, the
wider the spread of the effect. In this example, I'm keeping it pretty close to the
rock so everything else but Bonsai Rock gets darker.



If the rocks (or whatever should stand out in your photo) are still too dark,
then give the Adjustment Brush a try. Get the Adjustment Brush (K) from the
toolbox, then increase the Exposure setting, and paint over the rocks in the
foreground, as well as Bonsai Rock in the upper left. I'm also adding just a tiny bit
of warmth to the rock by increasing the Temp setting a bit, so the rock doesn’t
appear too blue.




While you have the Adjustment Brush options open, it's a good idea to take a
look at some other things in the image. For example, whenever you brighten a
dark area, you run the risk of introducing noise to the photo—you’ll probably have
to zoom in quite a bit to see it. If that happens (we have a little here), just increase
the Noise setting. But, since noise reduction tends to blur the photo a little,
increase the Sharpness setting, as well, to help counteract it.

Okay, that's just about it. But, there’s one tiny thing that's bugging me: there’s a
little reflection at the top of Bonsai Rock. It could be a water drop or a smudge on
the lens, but either way, it's kinda distracting. This would be tough to fix using the
Spot Removal tool in Lightroom, so I'm going to jump over to Photoshop for it. Go
under the Photo menu, under Edit In, and choose Edit in Photoshop CC (again,
it's the same for CS6, CS5, etc.).



Once you're in Photoshop, get the Clone Stamp tool (S), press-and-hold the
Option (PC: Alt) key, and click to sample an area next to the spot. Then, just paint
over it to remove it. When you're done, from the File menu, choose Save, then
close your image to return to Lightroom with your final image.
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CHAPTER ©

WATERFALLS

Itfs hard to talk about landscapes without talking about waterfalls.
There's just something that's so captivating about running water. And,
when you're able to use a neutral density filter to slow the shutter speed
and really capture the movement and silky effect in the water, you can
create some incredible photos. But, they do come with their own chal-
|enges when it comes to edi’ring. First off, waterfalls tend to have lots
of trees, branches, and distractions around them. Not to mention, you
have to balance the exposure of the areas su rrounding the water with
the bri'g"ll white water itself, without losing any detail in the water. But,
when it's all done, they’re some of my favorite photos.




cuartir6: WATERFALLS

This photo is of Sol Duc Falls in Olympic National Park. It's a gorgeous waterfall
that's almost hard to capture because it gives off so much mist in the air that your
lens constantly gets water drops on it. The photo was taken in early morning, but
there was enough sunlight that my shutter speeds made the water look frozen.
So, | put on a 3-stop neutral density filter and that let me slow the shutter speed
down to about a half-second and capture that smooth, silky water effect.

The photo is a bit dark, so increasing the exposure helps out a lot. Adding
some warmth to it with the Temp slider will help the overall mood, too. Since you
don’t want the water to get too bright, reduce the Highlights and that’ll bring back
some more detail and texture in the falls. We do have some lost detail in the
shadows, so increasing that will help, as well. And, of course, the ol Blacks and
Whites sliders should get adjusted for this photo. When it comes to the Whites
though, don’t push them too far or you'll lose detail in the water—just increase it
enough until you see some small areas of water get white, then pull back a little. |
increased the Clarity setting for a little more detail and added just a tiny bit of
Saturation to boost the colors (be really careful, though, not to go too high with the
Saturation or it'll look radioactive).



When it comes to exposure, color, and tone, there’s actually not much more
to do here than what we just did. But, there are a few more things we can do
that’ll dramatically help this photo. For starters, that log across the water in the
middle of the photo is a little distracting. This is a total judgment call, though.
Some people feel that because nature put the log there, it should remain in the
photo. If you're one of those people, then feel free to leave it. I'm going to assume
that some really mean person cut it down to ruin the photo for photographers and
go ahead and remove it, so he doesn’'t win ;-). So, select the Spot Removal tool
(Q) from the toolbox, make sure the Brush is set to Heal, and then paint over the
log (as shown here). Lightroom does a pretty good job of removing it.



Now do the same for the log on the right side of the photo. In this case, Light-
room didn’t do too great of a job removing it and actually replaced it with part of
the waterfall itself. No sweat, though. If that happens, just click on the sample
area dot you see on the photo and move it over something that looks like it'll be a
better match for the area you'’re trying to remove (as shown here).
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At this point we’ve pushed Lightroom pretty far when it comes to removing
the distractions in the photo. If you really spend some time, you could try to
zoom in on the top left of the photo and painstakingly paint over the people on the
bridge to get rid of them. Or, you could leave them, if they don’t bother you. Or,
you could use Photoshop, which is exactly what | did here. Just go under the
Photo menu, under Edit In, and choose Edit in Photoshop (or just press
Command-E [PC: Ctrl-E]). With the photo open in Photoshop, zoom in on the
people and that large piece of dead wood coming up out of the ground next to
them, and use the Clone Stamp tool (S) to remove them. Remember, with the
Clone Stamp tool you Option-click (PC: Alt-click) to sample an area, and then
paint over the area you want to remove (as I'm doing here with the piece of
wood).
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And, if you're really feeling adventurous, you could use the Spot Healing
Brush to paint over some of the tree near the lower-left corner that's sticking up
into the waterfall. Between cloning and healing, it would take some patience and
time to get rid of the entire tree. But a couple of quick swipes with the Spot
Healing Brush (J) at the top parts of the tree should at least help reduce its overall
distracting impact on the photo. When you're done cleaning the photo up a bit,
from the File menu, choose Save, and then close the image to return the final to
Lightroom.
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Okay, one last thing. The newly edited copy of the photo is back in Lightroom at
this point, and normally, I'd add a vignette to finish things off. But, | really want to
draw attention to the waterfall here, so we’ll add a Radial Filter effect instead. Get
the Radial Filter (Shift-M) from the toolbox, reduce the Exposure setting, and
click-and-drag over the rocks and top of the waterfall. It's almost like putting a
spotlight on the area and really helps to draw attention to the nicest part of the
photo.









CHAPTER 7/

THE CLOUDY DAY

If you learn anything about landscape photography, hopefully you
learn that a huge part of it is luck. Luck that you wake up early enough
in the morning for a beautiful sunrise or go out one evening and have
a beautiful sunset. But, if you're reading this, you've prodey already
learned that's not always the case. Sometimes (and, if you're like me, dll
the time), you get icky weather. Sometimes you just flat out get miserable
weather. But, with a little creative post-processing you can take those
cloudy photos and do something more with ‘em.




CHAPTER 7: THE CLOUDY DAY

What | just mentioned is exactly what happened the day | was traveling to Death
Valley. Along the way there, | was hoping to pull over and shoot as | drove.
Instead, the clouds rolled in.

Color and tone can play a big factor in dramatic cloudy photos like this. So,
white balance settings really mean a lot here. Overall, | think a warmer color will
help, so I'll move the Temp slider to the left. The exposure is a little dark, so I'll
increase that just a little so the rest of the photo doesn’t get too bright. Dramatic
clouds can usually be enhanced by reducing the Highlights setting quite a bit, and
the foreground is a bit dark, so I'll increase the Shadows. From there, you already
know the drill. Do the Option-click (PC: Alt-click) trick on the Blacks and Whites
sliders to find your black and white points.



Next, you’ll notice the Clarity slider works great on cloudy photos. It really
helps to enhance the detail and texture in the clouds. However, | don’t want to add
too much clarity to the foreground, so be careful if you see things getting that
ultra-detailed look. It may look great in the sky, but bad somewhere else. In this
example, you'll see (in a moment) how you can add more clarity to just the sky
and clouds. And, believe it or not, even though this is a fairly colorless photo,
Increasing the saturation will help add some nice color to the photo.



All right, the rest of the work is pretty simple and revolves around really
making the clouds dramatic. Select the Graduated Filter (M) from the toolbox and
decrease the Exposure setting. Now, click-and-drag from the top downward to
darken the sky a little. Not bad, right? That definitely helps out.

Ready for this? While you still have the Graduated Filter active, in addition to the
Exposure slider adjustment, try increasing the Clarity setting. Rather than adding



clarity back in the Basic panel, this method lets us add it to just the sky.

Okay, now this next part is really cool. Click on New at the top right of the
Graduated Filter options, then drag downward one more time. Yep, you can
actually add Graduated Filter adjustments on top of Graduated Filter adjustments.
And, whatever settings you use get intensified. In this example, | decreased the
Exposure and increased the Clarity setting in the first adjustment. But, | think the
sky is getting too dark, so | reset the Exposure slider to zero and left the Clarity
setting cranked up. You can continue to stack as many filters as you want on top
of each other to intensify the effect, but | actually think that two is plenty here.



TIP: Resetting Your Sliders

You can double-click on the name of any slider in the Develop module to reset it to
its default value of O (zero).

Next, let’'s remove some of the sensor spots in the sky. Get the Spot Removal
tool (Q) from the toolbox and don't forget to turn on the Visualize Spots checkbox
beneath the preview area, so you can see where the spots are. Just be aware that
the Visualize Spots option won't see all of the spots here because there are
clouds in the sky, but it definitely does help. Once you turn it off, it's a good idea to
zoom in and take a look around the photo for any more spots lurking about.



Finally, go to the Effects panel and finish things off with a vignette. If you've
got a cloudy photo like this, and you've already added a lot of drama to the sky
with the Graduated Filter like we have here, be careful with the vignette settings—
you don’t need to go too dark. Make sure you lower the Midpoint setting, though,
and increase the Feather setting, so that the edges don't look artificially darkened.




Well, everyone, there you have my landscape post-processing workflow.
Hopefully, after reading all this, you'll realize that it's fairly repetitive and there’s
almost a formula you can follow for each photo. Before we go, though, here are
two things I'll leave you with:

BRIAN MATTIASH

(1) Don't forget to stop by my landscape and outdoor photography blog at
www.mattk.com for more.

(2) I've included my basic gear list on the next page. Luckily, landscape
photography doesn’t require a lot of gear. A camera body, a few lenses, a tripod
and ball head, and some filters, and you’re good to go.

Enjoy and happy shooting!

i (L

Matt Kloskowski



MY GEAR

Camera Body
* Nikon D800
» Canon EOS 5D Mark 11l
Lenses
* 16-35mm (both Nikon and Canon have one)
* Nikon 18-35mm (cheaper and lighter than Nikon’s 16—-35mm and just as good)
» 24-70mm (Nikon, Canon, and Tamron all have one)
» 70—200mm (again, Nikon, Canon, and Tamron all have one)
Tripod & Ball Head
* Really Right Stuff TVC-33 (anything sturdy will do)
* Really Right Stuff BH-55
Filters
» Tiffen Neutral Density Filter (2-, 3-, 6-, and 9-stop screw-on filters)
» LEE Filters Big Stopper 10-stop Neutral Density Filter

* B+W Circular Polarizer Filter
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